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 lDIsl¾uh
01

1'1 mqxÑ f.j;a;l me< ksmojuq

 

                                                                    fuu mßÉfþoh wOHhkh lsÍfuka Tng"

	 ² mil ire nj mj;ajd .ekSug;a" 

	 ² N+ñfha li< tla/ia ùu wju lr .ekSug;a"

	 ² fndA. j.djg wjYH  frdamK øjH ilia lr .ekSug;a"

	 ² ;jdka kv;a;= lrñka f.j;= j.djlg wjYH me< 		

	  ksmojd .ekSug;a

						       yelshdjla ,efnkq we;'  

	 wm wjg mßirh ±l=ïl¿ ia:dkhla f,i mj;ajd .ekSu wmf.a 

is;a ;=< i;=g okjkakls'  wmf.a ksji wjg f.j;a; fuka u mdi,a 

f.j;a; o w,xldr j we;s úg m%fndaOj;a is;lska wOHdmk lghq;=j, 

ksr; ùug wmg yels jkq we;' ji úfika f;dr wdydr ,nd.; yels 

ùu" YÍrhg jHdhdu ,eîu" wu;r wdÞhï ,eîu wd§ m%fhdack /ila o 

w;am;a lr.; yels h' 

	 f.j;a;la ilia lr mj;ajd .ekSfï § wmf.a wjOdkh fhduq 

l< hq;= lreKq rdYshls' tu lreKq w;ßka b;d jeo.;a jk lreKq 

folla ms<sn| j fuu mdvfï § wmf.a wjOdkh fhduq lruq'

tajd kï

      	 ² f.j;af;a mi idrj;a f,i mj;ajd .ekSu

          ² f.j;af;a j.d lsÍug wjYH me< ksmojd .ekSu h'

f.j;af;a mi idrj;a f,i mj;ajd .ksuq'

	 mi" fnda. j.dj i|yd wjYH jk uQ,sl idOlhls' Ydl ord 

isákafka;a Ydlj,g wjYH fmdaIKh ,nd fokafka;a mi h' mfiys 

idrj;a nj wvq ùug fya;=jk lreKq lsysmhla my; oelafõ'

²  È.ska È.g u fnda. j.d lsÍfuka mfia fmdaIl fldgia bj;a ùu

²	 mi fidaÞmd¿jg ,la ùu

²	 mig fmd,s;ska" ma,diaála" úúO lDIs ridhksl øjH yd 			

	 bf,lafg%dksla WmlrKj, fldgia wd§ wmøjH neyer lsÍu'
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fuu lreKq w;=frka mi fidaodmd¿ ùu je<elaùug;a" N+ñfhys wmøjH 

tl;= ùu wju lr .ekSug;a .; yels l%shdud¾. ms<sn|j úuid n,uq'

mi fidaÞmd¿ ùu j<lajuq

	 mi fidaÞmd¿j hkq j¾Idj fya;=fldg 

f.k u;=msg we;s idrj;a mia ;Ügq fia§ 

hdu h' fuu ydksh nyq, j isÿjkafka nEjqï 

bvï j,h' jeis ìxÿ fõ.fhka mi u;g 

jefgk úg mia wxY= tlsfklska fjka jk 

w;r nEjqu Tiafia my<g .,d hk jeis 

c,h iu. mia wxY= o .idf.k hhs'

	 fï wkqj fidaÞmd¿j je<elaùfï § wmf.a 

wjOdkh fhduq l< hq;= lreKq folls' 

	 ²	 jeis ìxÿ fmdf<djg jefgk úg mia wxY= fjka ùu je<elaùu 

	 ²	 jeis c,h my<g .,d hdfï fõ.h wvq lsÍu

fï i|yd wmg l< yels foa ms<sn|j úuid n,uq' 

Ôj ndOl fh§u	

	 fuhska woyia jkafka jeis ìxÿ fmdf<djg jefgk úg mia wxY= fjka 

ùu je<elaùug;a" jeis c,h .,d hk fõ.h wvq lsÍug;a ÈYdj yria 

lrñka úúO Ydl isgqùu h' ta i|yd ksoiqka lsysmhla my; oelafõ'

f.j;af;a my< udhsïj,g 

.a,sßiSãhd jegla isgqùu

mi wdjrKh lrñka 

jefvk jÜglald" lelsrs 

wd§ je,a fnda. j.d lsÍu

c,h .,dhk ÈYdj yria 

lrñka fiar" iejekaord wd§ 

Ydl jeá isgqùu

 ²	 c,h .,d hk ÈYdj yria lrñka f.dgqfld< uql=Kq jekak wdÈ 		

	 m,d fnda. isgqúh yels h' 	

  wêl f,i fidaodmd¨jg ,la jQ 

N+ñhla 
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wÔj ndOl fh§u

	 wjg mßirfhka imhd .; yels wÔù øjH ndOl f,i fhdÞ .ksñka 

fidaÞmd¿j wvq l< yels h' fuys § c,h .,d hk ÈYdj yria lrñka 

.,a" ,S fldagq" fmd,ams;s wdÈh ke;am;a lsÍu uÕska yd mia jeá ilia 

lsÍu uÕska c,h .,d hdug ndOd l< yels h' jeis ìxÿ mia u;g 

fõ.fhka m;s; ùu yd mia wxY= fjka ùu wvq lsÍu i|yd mrK mdmsis" 

,Kq meÿre" f.daks fmd,siela Wr wdÈh mia u; t,d ;eìh yels h'

 	 ;j o mi u;=msg msÿre fmd,a w;= wd§ øjHj,ska wdjrKh lsÍfuka 

o fidaodmd¿j wvq l< yels h'

mrK rn¾ mdmsis t,Su mia msrjQ Wr yria lsÍu .,ajeá fh§u

 

Ôj yd wÔj ndOl ixl,kh lr fh§u	

	 mi u; mrK ,Kq meÿre f.daks wd§ we;sß,a,la oud tys ;ekska 

;ek isÿre lr tu ia:dkj, me< isgqúh yels h'

nEjqu yria lrñka mia 

msrjQ f.daks ;nd tu 

f.daks isÿre lr me< 

isgqùu

nEjqfuys fndA. isgqjd 

msÿrej,ska fmdf<dj jiqka 

lsÍu

nEjqu yria lrñka ilik ,o mia 

jeá u; fmd,s;ska t,d th isÿre 

lr fndA. isgqjd mia jeá w;rg 

msÿre fh§u
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 l%shdldrlu 1'1

² Tnf.a mdi,a f.j;af;ys fidaodmd¿jg ,la jQ ia:dk y÷kd.kak' 

² Tng imhd .; yels Ôù iy wÔù øjH ndOl f,i 			 

  fhdod.ksñka fidaodmd¿j je<elaùug lghq;= lrkak' 

wmøjH ksis whqßka l<ukdlrKh lruq

	 m%fhdackhg .; fkdyels øjH f,i i,lñka neyer lrk wmøjH 

ksis f,i l<ukdlrKh l<fyd;a tajd iïm;a f,i kej; m%fhdackhg 

.; yels jkq we;' 

fjka 

fkdl<fyd;a

fjka 

l<fyd;a

wmøjH

 
 li<  iïm;a

	

	 wmøjH m%Odk jYfhka wdldr follg j¾. lr ±laúh yels h' 

tkï Èrdm;a jk wmøjH yd Èrdm;a fkdjk wmøjH f,isks'  

Èrdm;a jk wmøjH- uq¿;ekaf.hska bj;,k øjH ^t<j¿" m,;=re 

wdÈfhys fmd;=" fmd,a l=vq" b÷,a& yd .ia j,ska jefgk fld< wdÈh fõ'

Èrdm;a fkdjk wmøjH -fmd,s;ska" bá frÈ" fmd,siela Wr" fmd,a lgq" 

fnda;,a lgq" ms.ka lgq" áka" ysia îu fnda;,a" mdkSh c, fnda;,a 	
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	 fuu wmøjH foj¾.h w;=frka mßirhg jeä jYfhka wys;lr 

jkqfha Èrdm;a fkdjk wmøjH h'

	 wmøjH l<ukdlrKfha uq,sl u wjia:dj wmøjH fjka fjka j 

tl;= lsÍu h' fuh wmøjH ckkh jk wjia:dfõ u l< hq;a;ls' 

Èrdm;a jk wmøjH l<ukdlrKh lsÍu

	 ksjil fyda mdi,l tl;= jk ish¨ u wdldrfha Èrdm;ajk wmøjH 

fldïfmdaiaÜ fmdfydr ksIamdokh lsÍfï wuqøjHhla f,i fhdÞ.; 

yels h' fldïfmdaiaÜ fmdfydr ie§fï úúO l%u we;;a jvd;a myiq 

l%uhla f,i fldïfmdaiaÜ fldgq fyj;a l+vd l%uh ye¢kaúh yels h' 

l%shdldrlu 1'2 

 fldïfmdaiaÜ fldgqjla idouq

wjYH øjH

²	 óg¾ 1 1$2 la muK È. yd fi'ñ' 2-3 muK úIalïNh we;s ,S   	

	 fldagq fyda mqjla má fyda wuq .a,sßiSähd fldagq 35la muK 

²	 WK ,Shla fyda ng,Shla m,d ilia lr.;a 	

	 keúh yels má lsysmhla'

²  fldyq ,Kq 

wjYH WmlrK- (-------- 

W±,a,la"  w,jx.=jla" msyshla

ilia lsÍfï mshjr 

² fldïfmdaiaÜ fldgqj ieÈug f;drd.;a 

ia:dkfhys N+ñh msßisÿ lr.kak' 	

² 1 rEmfha fmfkk mßÈ úIalïNh fi'ñ' 60 la 

muK m<,g jD;a;hla ,l=Kq lr.kak'  

² tu jD;a;fha mßêh u; fi'ó' 4-5 la muK mr;rh 

we;sj fi'ñ' 20 la muK .eUqrg isÿre idÞ.kak' 

^2 rEmh& fï i|yd w,jx.=fõ W,a fl<jr Ndú; 

l< yels h'
1 rEmh
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 		 2 rEmh         	 3 rEmh

² tu isÿre ;=< by; imhd .kakd ,o fldagq isgqjd tAjd fkdfi,afjk 

mßÈ ysr lr .; hq;= h' .a,sßiSßhd fldagq isgqjkafka kï tajdfha uy; 

me;a; my<g isák fia isgqjd tAjd uq,a wÈk ;=re i;shla muK c, 

iïmdokh l< hq;= fõ'

 

² 3 rEmfha ±lafjk mßÈ" isgqjk ,o fldagq jgd WKmá ;nd" fldyq 

,Kqj,ska ne| Yla;su;a lr.; hq;= h' 

	 fufia ilid .;a l+vhg Èrdm;a jk ́ kE u wmøjHhla ±ñh yels h' 

fldïfmdaiaÜ fldgqfõ m;=<g wdikakj ,S fldagq w;ßka fldïfmdaiaÜ 

bj;a lr.; yels h' fuu fldïfmdaiaÜ f.j;af;a fnda. j.djg ±óug 

iqÿiq fõ' 

	 fldïfmdaiaÜ fldgq ieliSfï § wuq .a,sßiSähd fldagq fhdÞ.kakd 

úg tAjd me<fõ' bka ,efnk m;% o lvd fldgqj ;=<g ±ófuka 

fldïfmdaiaÜj, idrj;a nj jeäl< yels jk w;r fldgqj jeä ld,hla 

mj;ajd .; yels fõ'

fnda.j,g fldïfmdaiaÜ fh§fï jdis

	 ²	 Ydlj,g wjYH fmdaIKh ,nd §u

	 ²	 mi nqre,a ù mi ire ùu 

	 ²	 mfia f;;ukh r|jd ;nd .ekSu

fkdÈrk wmøjH l<uKdlrKh lsÍu

	 fkdÈrk wmøjH mßirhg ydkshls' kuq;a ñksidf.a úúO wjYH;d 

i|yd fkdÈrk øjHj,ska ilia lrk úúO NdKav yd úúO fkdÈrk 

ojgk iys; wdydr øjH mßfNdackhg ñksid mqreÿ ù we;' tneúka 

wmf.a tÈfkÞ lghq;=j, § fkdÈrk wmøjH ckkh ùu wju lsÍug 

mshjr .; hq;= fõ' tA i|yd .; yels ls%hdud¾. my; ±lafõ' 
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1'	 Ndú;h wju lsÍu$ Ndú;fhka je<lSu ^Reduce& 
	 Ndú;h wju lsÍu fyda Ndú;fhka je<lSu ksid wmøjH ckkh 		

	 ùu wju fõ' fuh wmøjH l<ukdlrKfha jvd;a jeo.;a u 		

	 mshjr hs'

	 ² fj<|fmd<g hdfï § frÈ nE.hla fyda mka nE.hla /f.k 		

	   hdfuka ksjfia fmd,s;ska Wr tla /ia ùu wju fõ'

	 ²	wdydr t;Su i|yd fmd,s;ska fld< fjkqjg flfi,a fld< fyda   	

	 lEu fmÜá Ndú; lsÍfuka Èkm;d mßirhg fmd,s;Ska uqÞ yeÍu 	

	 wvq l< yels fõ'  

2'	 kej; Ndú;hg .ekSu ^Reuse& 
	 Ndú;h ;=<ska tla /ia jk wmøjH kej; m%fhdackhg .ekSu ms<sn|j 

wmf.a wjOdkh fhduq l< hq;= h'

²	 f.j;af;a îc me< lsÍu i|yd ys,a fmd,algq" ysia fhda.Ü fldamam" 

ysia îu fldamam wdÈh fhdÞ .; yels h' 

²	 me< yd îc isgqùug ysia lsßmsá Wr úúO fmd,s;ska Wr úúO ma,diaála 

n÷ka" mrK gh¾ fhdÞ.; yels h' 

ysia ma,diaála n`ÿkafmd,a lgqysia lsrs yÜá mrK gh¾ 

3'	 m%;splS%lrKh lsÍu ^Recycle& 
			   wmøjH l<ukdlrKfha oS ;j ÿrg;a Ndú;hg .; fkdyels 

wmøjH m%;spl%SlrKh l< yels h' wmøjH m%;splS%lrKh hkq hï 

wmøjHhla" fjk;a m%fhdackj;a wuqøjHhla njg m;a lsÍu hs' 

	 fkdÈrk wmøjH m%;splS%lrKh lsÍu mdi,a fyda ksjdi wdY%s;j l< 

fkdyels jqj;a tAjd tla/ia lr m%;splS%lrK lsÍu i|yd  m<d;a 

md,k wdh;k fj; fyda fm!oa.,sl tl;= lrkakka fj; Ndr Èh 

hq;= h' 

	 Reduce, Reuse, Recycle hkqfjka ye`oskajQ by; i`oyka l< mshjr 	

	 ;=k wmøjH l<ukdlrKfha 3 R ixl,amh kï fõ'  
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	 fuu ixl,amhg wkqj wmøjH njg m;a jk foa mßyrKh wvq lrk 

úg kej; Ndú; lsÍug isÿjk m%udKh fnfyúka wvq fõ' ta wkqj 

m%;spl%SlrKh lsÍug isÿjk m%udKh b;d iaj,amhla fõ'

	 m%;spl%SlrK uOHia:dkj, § fkdÈrk wmøjH kej; m%fhdackhg 

.; yels ;;a;ajhg m;a lrkq ,efí' 

tys § ;j ÿrg;a m%;spl%SlrKh l< 

fkdyels j b;sßjk fldgia úúO 

l%u uÕska msßmyÿ (Treatment) lrkq 

,efí' fuu mshjf¾ § isÿ lrkqfha 

m%;spl%SlrKh l< fkdyels fldgiaj, 

;sfnk úI nj wvq lsÍu" wvq bv lvl 

neyer l< yels mßÈ m%udKhg l=vd 

lsÍu wdÈh hs' fuu mshjfrka miq tu 

fldgia (Trash) mßirhg ydks fkdjk 

wdldrhg neyer lrkq ,efí' 

	 Treatment yd Trash hkqfjka ye`oskajQ by; i`oyka l< mshjr fol 

wmøjH l<ukdlrKfha 2T ixl,amh kï fõ'  

f.j;af;a isgqùu i|yd frdamK øjH ilia lruq'

	 fnda. j.dfõ § isgqùug .kakd  îc w;= len,s" ;jdka me< wdÈh 

frdamK øjH f,i y`ÿkajkq ,efí' isgqùu i|yd frdamK øjH ilia lr

.kakd whqre ms<sn|j wmf.a wjOdkh fhduq lruq' tla tla fnda. j¾. 

j.dfõ § isgqùug .kakd frdamK øjH fuka u tu frdamK øjH ilia 

lr .ekSfï l%u o tlsfklg  fjkia fõ' 

3 R ixl,amh
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l%shdldrlu - 1'3

isgqùu i|yd îc ilia lruq'

wjYH øjH iy WmlrK

	 ² fyd¢ka bÿKq miq úh<d.;a ñßia lr,a lsysmhla

	 ² fyd¢ka bÿKq ;lald,s f.ä lsysmhla

	 ² fyd¢ka bÿKq jïngq f.ä lsysmhla

	 ² úh<s nKavlald lr,a  lsysmhla

	 ² úh<s uE lr,a  lsysmhla

	 ² úh<s" msßisÿ" l=vd fndA;,a lsysmhla ^îc 	 	

	  .nvd lsßug&

	 ² msßisÿ lvodis lsysmhla

	 ² >klï frÈ lene,a,la iy c,h

	 ² msyshla 			

	 ² f;a yekaola

	 ² oe,a fmrKhla	

	 ² n÷ka lsysmhla ^îc /ia lsÍug&	

	 ² rn¾ w;a fïia 

mQ¾j iQodku  

² isgqùug îc /ia lsÍu i|yd m, ,nd .ekSug Wiia ,laIK we;s 	

   uõ Ydl f;dard .kak' 

² ;lald,s" jïngq yd ñßia m, .fia ;sìh § u fyd¢ka bfokakg yer 	

  fk<d .kak' 

² nKavlald iy uE m, uõ Ydlfha u fudard fyd¢ka úh¿kq miq 	

  fk<d .kak'

m,fhka îc fjkalr .ekSu 

 	 ² ñßia (- fyd¢ka b§ r;=mdg jQ lr,a fk<d msyshlska m<d îc fjka 	

	  lr.kak'

	 ² ;lald,s (-fyd¢ka bÿKq ;lald,s f.ä fk<d msyshlska m,d îc 		

   fjka lrf.k >klï frÈ lene,a,la u;g oud w;=,a,d tys msg; 		

    we;s fij, yd udxY, fldgia bj;a lr fyd¢ka fidaÞ fmrd .kak' 

	 ² jïngq (-fyd¢ka bÿKq jïngq f.ä fk<d tAjd msyshlska m,d îc 		

	 fjka lr udxY, fldgia bj;a  jk fia fyd¢ka fidaÞ fmrd .kak'	

	 ² nKavlald" uE (-ujq Ydlfha u úhf<kak g yer fk<d.;a lr,a 		

    m,d îc fjkalr .kak' wjYH kï lr,a msáka u jqj o úh<d l,a 	

	  ;nd.; yels h'

îc ilia lsÍug wjYH WmlrK 

lsysmhla
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îc úh<Su 

² M,j,ska fjka lr.;a ñßia";lald,s yd jïngq îc msßisÿ lvodishla 	

  u; oud m<uqj mjfka o fojkqj uo wõfõ o f;jkqj ;o wõfõ o 		

  úh<d .; hq;= h' tlajr u ;o wõjg oeófuka  îc yels<S hhs'

² lr,aj,ska fjka lr .;a nKavlald iy uE îc o wõfõ úh<d .; 		

	 hq;= h'

îc .nvd lsÍu

úh<d .;a îc fndA;,aj, oud iq<x fkdjÈk fia uQä fyd¢ka jid úh<s 

isis,a ia:dkhl .nvd lr ;nkak' YS;lrKhla ;=< .nvd lsÍfuka 

fuu îc jeä l,la ;nd .; yels h' 

	 fndA. j¾. lsysmhl îc ilia lr.kakd wdldrh my; rEm igykaj, 

oelafõ'

ñßia îc ilid.ekSu

;lald,s îc ilid.ekSu

jïngq îc ilid.ekSu
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 nKavlald îc ilid.ekSu uE îc ilid.ekSu

	 we;eï úfgl Wiia ,laIK iys; ujq Ydlhlska ,nd.;a îc isgqùfuka 

tu  ujq Ydlfha  mej;s ish¨ u ,laIK fkdmj;sk wjia:d we;' 

tneúka uyd mßudKfha jd‚c j.d i|yd  lDIsl¾u fomd¾;fïka;=j 

u.ska ksmojk me< ,nd .ekSu iqÿiq h'

îc ;jdka lsÍu

	 iuyr fnda. j.d lrk úg îc ;jdka oud bka ,efnk me< lafIa;%fha 

isgqjkq ,efí' WÞ (-;lald,s" ngq" ñßia" 

kuq;a Wÿrd isgqùfï § uq,aj,g isÿ jk ydksj,g Tfrd;a;= fkdfok 

fnda.j, îc fl,ska u lafIa;%fha isgqjkq ,efí' 

 WÞ	 (-fndaxÑ" uE" uqx" jÜglald" lrú,

f.j;a;l isgqùu i|yd wjYH me< ,nd .ekSug m;=, isÿre lrk ,o 

l=vd n÷kaj, îc ;jdka oeóu m%udKj;a fõ'

l%shdldrlu  1'4

îc ;jdka lruq' 

wjYH øjH iy WmlrK

	 ² ;jdka oud isgqjk îc j¾. lsysmhla

	 ² ;jdka n÷ka ^ m;=, isÿre lr.;a mrK fíiï" ysia lsß yÜá" ysia 	

				    whsia lS%ï n÷ka&

	 ² u;=msg mia" fldïfmdAiaÜ fyda úh<s f.du

	 ² msoqre iaj,amhla

	  ² rhsishla 

	  ² w;a biafldamamhla

	  ² u,a nd,aÈhla

	  ² l=vd n÷ka lsysmhla
      



12 13

îc iQodkï lsÍu 

²	 fnd,a  îc bj;a lsÍu - fï i|yd îc c, n÷kl oud 	mdfjk 	

	 îc bj;alr c,fha .sf,k îc muKla f;dard.; hq;= h' 	

²'	 îc c,fha fmÕùu - m%frdayKh ùu i|yd wjYH c,h Wrd 			

	 .ekSug i`oyd îc meh 12la muK ld,hla c,fha fmd`.jd .; 		

	 hq;= h' 

udOH iQodkï lsÍu

 u;=msg mia yd fldïfmdAiaÜ rhsisfhka y,d .kak' u;=msg mia fldgia 

1 lg fldïfmdaiaÜ fldgia 1 la ñY% lr ;jdka udOH ilid .kak' 

îc isgqùu

    

4' n÷k msÿre ;Ügqjlska 

jid u,a nd,aÈfhka c,h 

fhdokak'

5' îc me< ùu wdrïN 

jk úg msÿre ;Ügqj 

bj;a lrkak'

2' ta u; iudldrj îc 

úiqrejd yßkak'

3' îc u;g ;jdka udOH 

oud uola w;ska ;o 

lrkak'

1' m;=, isÿre lr.;a 

n÷kaj,g ;jdka udOH 

mqrjd.kak'

	 ;jdk úhf<kakg fkd § u,a nd,aÈhlska c, iïmdokh l< hq;= h' 

îc me<jk úg msÿre wdjrKh bj;a lr me< j¾Okh ùu i|yd fyd¢ka 

ysre t<sh ,efnk ia:dkhl ;eìh hq;= h'  i;s 3 lska muK me< 

lafIa;%fha isgqùug yels fõ' 
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o~q lene,s uq,a woaojd .ekSu

	 iuyr fnda.j, me< ,nd.kafka 

o~q len,s isgqùfuks' tjeks we;eï 

fnda.j, o~q lene,s fl,ska u 

lafIa;%fha isgq jkq ,efí' WÞ (-n;," 

lxl=x" u[af[dlald" uql=Kqjekak 

we;eï fnda.j, muKla  o~q lene,s 

;jdka oud uq,a woaojdf.k bka miqj 

lafIa;%fha isgqjkq ,efí' WÞ#- f,uka

	 o~q len,s ;jdka ±óu f.j;af;a 

ìu fyda n÷kl fyda l< yels h' m;=< 

is÷re iys; lg m<,a n÷kl o~q len,s jeä ixLHdjla uq,a weoaoúh 

yels fõ' 

uq,a we§u i|yd isgqj we;s o~q len,s

	 l%shdldrlu---- 1'5

 - o~q lene,s uq,a woaojd .ksuq

wjYH øjH iy WmlrK

	 ² ;jdka n÷ka ^mrK fíiï" ysia lsß yÜá" ysia 		  	

whsia lS%ï n÷ka&

	 ² u;=msg mia" je,s" fldïfmdAiaÜ fyda úh<s f.du 

	 ² f,uka w;= len,s 

	 ² rhsishla" w;a biafldamamhla" u,a nd,aÈhla

	  ² lg m<,a n÷ka lsysmhla

mshjr 1 - n÷kaj, m;=, isÿre lr" rhsishlska 

y,d.;a u;=msg mia fldgia 1 lg fldïfmdaiaÜ fldgia 1la o je,s 

fldgia 1 lao ñY% lr idÞ.;a udOH mqrjdkak' 	

mshjr 2 - fndfyda úg isgqùu i|yd iqÿiq jkafka 

uOHia: f,i fïrE o~q len,s h' isgqùug .kakd 

o~q lene,a,l mqrela lsysmhla ;sîu iqÿiq jk w;r 

rEmfha ±lafjk mßÈ .eghlg my<ska .eghg 

wdikakj tys l| wef,ag lmd .kak' fuu o~q 

len,s j.d udOH msrjQ n÷kaj, isgqjkak'  uq,a 

wÈk ;=re fijK ia:dkhl ;nkak' wjYH úg § 

c,h iïmdokh lsÍu jeo.;a fõ' 

isgqùug iQodkï l< 

o~q len,a,la 

o~q len,a,la isgqjk 

whqre
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N+.; l| len,sj,ska me< ,nd .ekSu

	  we;eï fnda.j, l| fmdf<dj hg msysghs' tAjd N+.; l|ka f,i 

ye¢kafõ'  WÞ(- ly" bÕ=re" flfi,a" lsßw, 

idudkH jHjydrfha fïjd w, hehs ye¢kajqj o Ydlfha l| fldgia 

fõ' fuu N+.; l|ka len,s lr isgqùfuka me< ,nd.; yels h' fïjd 

fndfydaúg fl,ska u lafIa;%fha isgqjk w;r n÷kl jqj o isgqjd me< 

lr .; yels h' 

l%shdldrlu 1'6 

 N+.; l| len,sj,ska me< ,nd .ksuq

wjYH øjH iy WmlrK

	 ² ;jdka n÷ka ^mrK fíiï" ysia lsß yÜá" ysia whsia lS%ï n÷ka&

	 ² u;=msg mia" je,s" fldïfmdAiaÜ fyda úh<s f.du

	 ² ly iy bÕ=re w, len,s lsysmhla

	 ² rhsishla" w;a biafldamamhla" u,a nd,aÈhla

	  ² lg m<,a n÷ka lsysmhla

mshjr

1' o~q len,s isgqùfï § mshjr 1 ys isÿ l< wdldrhg n÷ka mqrjd.kak'

2' w, l=vd len,sj,g lmd.kak' 3' mqrjd.;a udOH u; w, len,s 

;nkak'

4' ta u;g kej; j.d udOH oud hka;ñka ;o 

lrkak' fuh  u;g msÿre fyda fld, frdvq oud 

u,a nd,aÈhlska c,h oukak'

      5' w, len,sme< jQ miq	
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j.d m;%sldjla ie,iqï lruq

	 l=vd fyda úYd, mßudKfha f.j;a;la mj;ajd .ekSfï § tA i|yd 

fhdÞ .kakd øjH iy tÈfkÞ lrkq ,nk l%shdldrlï wdÈh ms<sn| j 

igyka ;nd .ekSu jeo.;a fõ' 

	 f.j;a;la mj;ajd .ekSug wjYH fhojqï jk îc" me<" fmdfydr" 

c,h yd ñksia Y%uh wdÈh o ìï ieliSu" ;jdka ±óu" me< isgqùu wdÈ 

l%shdldrlï o" tu fhojqï i|yd jeh jQ uqo,a ms<sn| j igyka mj;ajd 

.ekSu id¾:l j f.j;a; kv;a;= lsÍug msájy,la fõ' 

	 fuu mdvfï § îc ksIamdok l%shdj,sfhys wms ksr; jkafkuq' tu 

l%shdj,shg wÞ< j j.d m;%sldjla ilia lr.kakd whqre ms<sn| j wmf.a 

wjOdkh fhduq lruq'

	  j.d m;%sldjla ilia lsÍfï § wkq.ukh l< yels l%u 2ls'

		  1' lvÞisj, ^fmd;a m;aj,& f,aLk.; lsÍu

		  2' mß.Klh weiqfrka j.d m;%sldj ilia lsÍu 

	

	 Tnf.a mdif,a mß.Kl myiqlï ;sfí kï" fuu fojk l%uh 

Wmfhda.S lr.; yels h'

mß.Klh weiqfrka j.d m;%sldjla ilia lsÍu

	 fï i|yd Ndú; lrkq ,nkafka joka ieliqï ^Word Processing& 
uDÿldx.hhs' 

	 mdi,a mß.Kl úoHd.drj, Ndú; jk mß.Kl fufyhqï moaO;s   

(Operating System) ;=,  fï i|yd Ndú; l< yels joka ieliqï 

uDÿldx. my; ±lafõ'

² Microsoft Office fufyhqï moaO;shg wÞ< j Microsoft Office Word       
joka ieliqï uDÿldx.h 

² Isuru Linux fufyhqï moaO;shg wÞ< j LibreOffice writer joka 

ieliqï uDÿldx.h 
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j.d m;%sldj ieliSu i|yd LibreOffice write uDÿldx. Ndú; lruq' 

	 LibreOffice uDÿldx.hg msúiSu i|yd ’’Dash Home’’ 
ksrEmlh  u; la,sla lsÍfuka ,efnk fijqï ;srh u; writer ku 

h;=re,shkh  lsÍfuka fyda mß.Kl ;srh u; we;s   ksrEmlh 

u; la,sla lsÍfuka LibreOffice writer uDÿldx.hg msúish yels h' tu 

uDÿldx.h újD; jQ úg ,efnk w;=re uqyqK; my; ±lafõ'

	 fuu w;=re uqyqKf;ys Èiajk iïu; fuj,ï ;Srej (Standard 
Toolbar) yd yeviõ fuj,ï ;Srej (Formatting Toolbar) ms<sn| j 

Tn wOHhkh lr we;'

joka ieliqï uDÿldx. wdOdrfhka j.=jla ms<sfh, lruq'

 	 fï i|yd uDÿldx.fha fukq ;Ssrh (Menu Bar) u; we;s 
Table → Insert → Table → Enter lsÍfuka Insert → Table ixjdo 

fldgqjla u;= fõ'
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Insert → Table ixjdo fldgqj

	 fuys Name bÈßfhka j.=jg wod< kduh h;=re,shkh lrkak' 

Columns bÈßfhka j.=j i|yd wjYH jk ;Sre ixLHdj imhkak' Raws 
bÈßfhka j.=j i|yd wjYH jk fma<s ixLHdj imhkak' by; w.hka 

imhd OK l< úg Tng wjYH j.=j ,efnk w;r j.=j ;j;a yeviõ 

lsÍu i|yd jQ Table Toolbar ;Srh ,efí'

	

	 by; y÷kd.;a fuj,ï ;Sre u; uQislh r|jd f.k isák úg 

Tool Tip fldgqj ,efí' thska ksrEmlh fidhd.; yels h' tfuka u 

tys we;s i,l=Kq u.ska lr.; yels ld¾h ms<ssn| j woyila olajhs'

	 wu;r ;Sre yd fma<s we;=<;a lr .ekSu i|yd Insert Row/Insert 
column o ;Sre yd fma<s bj;a lr .ekSu i|yd bj;a lsÍug wjYH ;Srej 

fyda fma<sh u; lZirh ;nd Delete Row/Delete column Ndú;fhka  o 

tu ld¾hh bgqlr .; yels h'
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l%shdldrlu 1'7

1' Tn úiska lrkq ,nk l%shdldrlï ms<sn| f;dr;=re wNHdi fmdf;ys 

igyka lrkak' tA i|yd ksoiqkla f,i my; ±lafjk j.=j Wmfhda.S  

lr.kak'

2' Tnf.a mdif,a mß.Kl myiqlï we;akï mß.Kl weiqfrka 

f;dr;=re jd¾;d lrkak'

Èkh l%shdldrlu wjia:dj uqyqK mE 

.eg¨

fhdok 

,o ms<shï

fjk;a 

lreKq

2015' 

02'03

îc ;jdka 

lsÍu 

;jdka 

l< îc 

me<ùug 

fmr 

l=yqUqjka 

úiska îc 

/f.k 

hdu 

c, 

fíiul 

;enQ ,S 

lene,a,la 

u; ;jdka 

n÷k 

;eîu
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1'2 mdi,a j;a; o¾YkSh jk mßÈ N+ñ 
w,xlrKh lruq

 

                                                                    fuu mßÉfþoh wOHhkh lsÍfuka Tng"

² mdi,a j;af;a msysàug .e<fmk N+ñ w,xlrK ie,eiaula 		

  ks¾udKh lsÍug;a"

² ta i|yd fhdod.kakd Ydl y÷kd .ekSug;a"

² úúO ia:dkj,g WÑ; Ydl ;SrKh lsÍug;a"

² tu Ydlj,ska bgqjk ld¾hhka meyeÈ,s lsÍug;a" 

² mßirhg o¾YkSh fmkqula ,nd §ug fhdod .; hq;= oDv jHQy 	

    	   f;dard .ekSug;a 

						       yelshdjla ,efnkq we;'

	 hï mßirhla ±l=ïl¨ f,i ks¾udKh lr mj;ajd .ekSu" th 

olsk ish¨ fokdf.a u is;a i;=gq lrjkakls' mdi,a N+ñh o o¾YkSh 

whqßka w,xldr lsÍug Þhl ùu Tng uy;a lDma;shla f.k fok 

ld¾hhla jkq we;'

 

                 

	 N+ñ w,xlrKh i|yd fhdÞ.kakd úúO Wmdx. m%Odk jYfhka 

wdldr folls' tajd kï	 uDÿ Wmdx. yd oDv Wmdx. fõ' 

	 uDÿ Wmdx. hkq N+ñ w,xlrKh i|yd fhdÞ.kakd ish¨ u Ydl" 

mlaISka" iuk¨ka wd§ i;=ka h'  oDv Wmdx. hkq Ydl yd i;=ka yer N+ñ 

w,xlrKhg fhdÞ .kakd ish¨ u wðù øjH fõ' 
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uDÿ Wmdx. 

	 N+ñ w,xldrKfha § uDÿ Wmdx. f,i m%Odk jYfhka Ydl isgqjk 

w;r tu Ydl lrd meñfKk i;a;ajhka o" N+ñhg w,xlrKh f.k 

fohs' 

N+ñ w,xlrKfha § Ydlj,ska wfmalaId flrk ld¾hhka

² fijK ,nd.ekSu  

	 uehs" kq." fldÜgïnd wd§ úYd, Ydl isgqùfuka fijK ,efí'

²	ndysrg o¾Ykh ùug kqiqÿiq ia:dk jid ±óu  

	 jeisls<s" c, gexls wdÈh wdjrKh lsÍu i|yd ng wd§ Wi m÷re 

isgqúh yels h' 

²	mßirh j¾Kj;a lsÍu 

	 fuys § úúO j¾K iys; m;% yd u,a we;s Ydl isgqjkq ,efí' 	

²	mßirh iqj|j;a lsÍu i|yd

	 iqj|j;a u,a msfmk weÜfÜßhd" .däkshd" fjila u,a wdÈh isgjkq 

,efí' 

²	l=re,a,ka yd iuk¨ka wdl¾IKh lsÍu 

  l=re,a,kag wdydrhg .; yels m,;=re" Ydl yd iuk¨kag me‚ 

,nd.; yels u,a msfmk Ydl o isgqúh yels h'

²	wdydrhg .ekSu 

	 uql=kqjekak" f.dgqfld<" ;ïm,d" f.dajd" úúO j¾Kfha yd yevfha 

fldÉÑ" jïngq j¾." wdÈh N+ñ w,xlrKhg muKla fkdj wdydr 

jYfhka o .; yels h'	

N+ñ w,xlrKhg fhdÞ.kakd  Ydl

	 uDÿ Wmdx. f,i fhdÞ.kakd Ydl úúOdldr h' Ydlj, 

úYd,;ajh yd tajdfha j¾Ok ú,dih yd yevh wkqj" u,a msmSu wkqj 

Ydl úúO;ajhla fmkakqï lrhs' wjYH;dj wkqj fuu Ydl fhdod.

kakd  wdldr lsysmhls'

N+ñ w,xlrKfha §  Ydl fhdod.kakd wdldr lsysmhla

		  ² úYd, Ydl (large trees)
		  ² m÷re (shrubs)	
			   ² Ydl jeá ^hedges)
			   ² fndav¾ ^borders)		
			   ² wdjrK fnda. (cover crops)
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² úYd, Ydl	

	 WÞ (- *Slia ̂kq. j¾.& weye<" Èjq,a" cïnq" fmar j¾." fjr¿" W.=reiai" 

mdïj¾." Song of india 

  *Slia fnkacñkd weye<

² m÷re 

		  WÞ (- frdai" jo" boao" j;=iqÿ" YTT" fnda.kaú,d" uqiaiekao" 

fndaúáhd" .däkshd" v%eiSkd j¾.

  
YTTv%eiSkd j¾. .däkshd

² Ydl jeá ^hedges)
 	 msúiqï ud¾. fomila N+ñj, udhsïj,;a Ydl jeá ilikq  ,efí'
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fld, j¾K follska Ydl jeá folla iy oï 

meye;s Ydl fndAvrhla tlg fhdod we;s whqre
jo Ydl jeáhla

blafidard jeáhlaf.da,avka ÿ/ka;d jeáhla

² fndav¾ ^borders)  
 	 úúO ia:dkj,  udhsï fjka lr ±laùug;a" .uka lrk ud¾. fomi;a 

j¾Kj;a ñá Ydlj,ska fndav¾ ilikq ,efí' 

flda,shdia fndav¾ frdaysfhda fndavrhla
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²	 wdjrK Ydl 
WÞ (- ;DK j¾." fjdkavßx cq ^wandering jew&" tmsishd j¾." úúO 

j¾Kfha m;% iys; n;, j¾. 

tmsishd

j¾Kj;a m;% iys; n;,

fjdkavßka cQ

;DK j¾.

W÷msh,s

	 by; i|yka l%uj,g wu;rj lmamdÿ lsÍfuka o¾YkSh f,i 

úúO yev .kajk ,o Ydl o N+ñ w,xlrKh i|yd fhdod .efka'

yev .ekajQ Ydlhla Ydl yev .ekaùfuka lrk ,o ks¾udK

		  tfuka u wjYH;dj wkqj u,a msfmk Ydl yd úis;=re m;%sl Ydl o 

fhdod .; yels h' 
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²	u,a msfmk Ydl 
  	 jo" frdai" b.afidard" weka;+ßhï" fnda.kaú,shd" iSkshd" yhsfv%kaðhd

fnda.kaú,shd yhsfv%kaðhd iSkshd

²  úis;=re m;%sl Ydl 
 	 le,;shd" m;s%l weka;+ßhï" v%eiSkd" flda,shdia" iamhsv¾ ma,dkaÜ" 

m¾kdx." úis;=re m;%sl ynr,

m¾Kdx. úis;=re m;%sl ynr,le,;shd

N+ñ w,xldrKhg fhdÞ.kakd oDv Wmdx.
	 ²	 l¨ .,a					     ²  ,ka;erEï

	 ²	 fÞ< .,a 					     ²  l=re¨ c, n÷ka

 	 ² 	mshjr .,a  ^isfuka;s fyda ,S&		  ²  l=re¨ wdydr n÷ka	

	 ²	 nxl= ^isfuka;s fyda ,S&	   		  ²  fmdl=Kq 			 

²	 md,ï ^isfuka;s fyda ,S& 			   ²  Èh we,s

	 ²	 jegj,a ^isfuka;s fyda ,S&

	 ²	 wdrelal= ^isfuka;s fyda ,S

	 ²	 m%;sud $ uQ¾;s
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     l¨ .,a fhdod w,xlrKh lsÍu fÞ< .,a fhdod w,xlrKh lsÍu

;DK N+ñhl mshjr .,a fhdod w,xlrKh 

lsÍu

fndr¨ udj;l mshjr .,a fhdod 

w,xlrKh lsÍu

mshjr ;eîug ,S fldg 

fhdod .ekSu

nxl= f,i ,S fldg fhdod .ekSu

isfuka;s nxl= ;eîu jegj,a ieliSu
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wdrelal= fh§u fmdl=Kq yd md,ï fh§u

l=re¨ c, n÷ka ;eîuÈh we,s ieliSu 

,ka;erEï ;eîu 	 m%;sud $ uQ¾;s ;eîu
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l%shdldrlu 1'8 

  N+ñ w,xlrKhg wjYH iïm;a imhd .ksuq'

	 Tnf.a mdif,a mßirfhka imhd .; yels úúO uDÿ Wmdx. iy 

oDv Wmdx.j, f;dr;=re /ia lrkak' tu f;dr;=re  my; oelafjk 

j.=jg wkqj Tnf.a wNHdi fmdf;a i|yka lrkak'

 

 øjHh Wmdx.fha iajNdjh

uDÿ $oDv

N+ñ w,xlrKfha § 

fhdod .; yels 

wdldrh

úêu;a iy wúêu;a N+ñ w,xlrKh

		  N+ñ w,xlrKhg wjYH jk uDÿ yd oDv wx. N+ñfhys msysgqjkq 

,nk wdldrh wkqj m%Odk N+ñ w,xlrK l%u 2la y÷kd .; yels h' 

1'	úêu;a N+ñ w,xlrKh	 - fuh kshñ; yev;, wkqj ilik ,oaols' 

tkï jpk ,o Ydl úúO yevj,g lmamdÿ lsÍfuka o" jD;a;" p;=ri% 

wd§ cHdñ;sl yev;,j,g md;a;s" fmdl=Kq" Ydl jeá wdÈh ieliSfuka 

o úêu;a l%uhg N+ñ w,xlrKh lrkq ,efí' 
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wúêu;a N+ñ w,xlrKh 

 		  fuys § iajdNdúl whqßka Ydl jeãug bv fokq ,efí' fmdl=Kq" 

wä mdrj,a jeá wdÈh o wl%uj;a fmkqula ,efnk fia ks¾udKh 

lrkq ,efí' 

 

l%shdldrlu 1'9

 w,xlrKh lsÍug iqÿiq ia:dkhla mdi,a N+ñfhka f;dard .ksuq

	 Tfí .=re;=ud$ ;=ñh iuÕ mdi,a N+ñfhys úúO ia:dk  ksÍlaIKh 

lrñka w,xlrKh lsÍug iqÿiq ia:dkhla f;dard .kak' tu tla tla 

ia:dk iqÿiq ùug fyda kqiqÿiq ùug fya;= olajkak' ta i|yd my; 

oelafjk j.=j Tfí wNHdi fmdf;a msgm;a lr .kak' 

ia:dkh iqÿiqlï kqiqÿiqlï  f;dard 

.ekSu

Wod #-úoHd.drh 

bÈßmsg

mdi,a msúiqug 

fyd¢ka o¾Ykh 

fõ

fmdf<dfjys 

j<,k ,o c, 

k< we;'

        X 
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mdi,a N+ñhla w,xlrKh lsÍfï § ie,lsh hq;= lreKq

1' fhdod .kakd Ydl m%foaYfha foaY.=Khg .e<mSu

	 úh<s l,dmfha mdi,aj, N+ñ w,xlrKfha § lgql mßirhg 		

     Tfrd;a;= fok Ydl f;dard .; hq;= h' WÞ (-  fnda.kaú,d" wr,sh" 	

	 lfkare 

	 mßir WIaK;ajh wvq m%foaYj, ìf.dakshd m¾kdx. wdoS 			

	 Ydl isgqùu iqÿiq h' f;dard .;a ia:dkh" fijK iys; kï 		

	 fijK ms%h lrk le,;shd" ìf.dakshd" fmmfrdañhd" m¾Kx. wdoS 	

	 Ydl iqÿiq h' 

2' N+ñfha iajNdjh $ N+f.da,sh msysàu

	 N+ñfha msysàu wkqj Bg we;=<;a l< yels wx. fjkia fõ' 		

	 ;eks;,d N+ñhla i|yd ;DK msáhla we;=<;a l< yels h' 

3' imhd .; yels iïm;a j¾. yd m%udKh	

	 fuys § wjg mßirfha iq,n iïm;a fhdÞ .ekSu iqÿiq h' l¿.,a" 	

	 ,S fldg wdÈh myiqfjka imhd .; yels m%foaYj, tjeks Wmdx. 	

	 fhdÞ .ekSu jvd;a WÑ; h' .,a nyq, m%foaYj, .sßWhka  ielish 

	 yels h' 

4' jeh jk uqo,a m%udKh

	 mßirfhka fkdñ<fha imhd.; yels øjHj,g wu;r j 			

	 wfkl=;a oDv yd uDÿ Wmdx. i|yd uqo,a jeh lrkafka kï 		

     mdif,a yd Tnf.a wd¾Ól yelshdj ms<sn| j ie,ls,su;a úh 

	 hq;= fõ' 

5' jeh l< yels Y%uh	

	 Tng Wmldr ,nd.; yels jeäysáhka fyda fiajl uy;=ka fyda 		

	 isà o hkak u;" msysgqùug wfmalaIs; Wmdx. ms<sn|j ;SrK 		

 	 .; hq;=fõ' úYd, .,a" úYd, fldg wdÈh fhdÞ.ekSug hdu 

	 Tnf.a 	wdrlaIdjg .eg¨jla úh yels h' 
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N+ñ w,xldrK ls%hdj,sfhys mshjr 

1' wÞ< N+ñfhys mj;sk ;;a;ajh wOHhkh lsÍu (	

	 fuys § ie,ls,a,g .; hq;= lreKq lsysmhls'  

	 1	 N+ñfhka uq¿ukska u bj;a l< hq;= uDÿ yd oDv Wmdx. ms<sn|j    	

	 ;SrKh lsÍu'

	 2	 N+ñfha tu ia:dkj, u ;nd.; hq;= wx. ;sfí±hs fidhd ne,Su'

	 3	 ia:dk fjkia lr kej; msysgqúh hq;= wx. yÿkd .ekSu'

	 4	 N+ñhg w¨f;ka we;=<;a l< hq;= wx. fudkjd±hs ;SrKh lsÍu'

	 5	 by; lreKq we;=<;a lr o< ie,eiaula we| .ekSu'

	 6' f;drd.;a uDÿ yd oDv wx. ie,iqï l< ia:dkj, msysgqùu'

l%shdldrlu 1'10

 N+ñ w,xlrKh i|yd o< ie,eiaula w¢uq'

wjYH øjH 

	 A4 m%udKfha iqÿ lvodishla

	 mekai,la 

	 ulkhla

	 mdg mekai,a fyda mdg l+re ^r;=" fld, iy ks,a &

	 N+ñ w,xlrKhg f;dard.;a ia:dkh fyd¢ka ksÍlaIKh lr tys 

udhsï Tfí lvodish u; ,l=Kq lr.kak'

Tfí .=re;=ud$;=ñh yd mka;sfha wfkl=;a isiqka iu. idlÉPd lrñka"

	 ² tys oekg mj;sk uDÿ Wmdx. yd oDv Wmdx. w;=ßka tu 			

	 ia:dkfhysu ;nd.; hq;= Wmdx.  ie,eiafuys r;= mdáka 			

	 ,l=Kq lrkak'

	 ² iïmQ¾Kfhka u bj;a l< hq;= wx. fld, mdáka ,l=Kq lrkak' 

	 ² ia:dk fjkia l< hq;= wx. we;akï tajd w¨f;ka msysgúh hq;= 		

	  ia:dk ks,a mdáka ,l=Kq lrkak' 

Tn úiska i,l=Kq lrkq ,nk wx. fudkjdoehs ie,iqfuys kï lr 

;nd .ekSug u;l ;nd.kak'
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l%shdldrlu 1'11

 -	 f;dard .;a uDÿ yd oDv wx. ie,iqï l< ia:dkj, msysgqjuq'

wjYH øjH

	 mdi,a mßirfhka imhd .kakd ,o uDÿ yd oDv Wmdx.

	 Tnf.a ksfjia weiqfrka imhd .kakd ,o uDÿ yd oDv Wmdx.

	 ñ, oS .kakd ,o uDÿ yd oDv Wmdx. ^yelskï muKla&

wjYH WmlrK

	 Wo¨			     f¾lal	  		  u,a lmk l;=re

	 filáh¾		    w,jx.=jla 		  w;a uq,a¨ 

	 w;a biafldamam	   u,a nd,aÈ			   ñkqï máhla 

Tng bgq lsÍug we;s ld¾hhka wkqj wjYH jk WmlrK fjkia úh 

yels h'

	 ² Tn úiska ilid .;a ie,eiaug wkqj N+ñ w,xlrK lghq;=j, 		

	   ksr; jkak'

	 ² m<uqfjka bj;a l< hq;= øjH tu N+ñfhka bj;a lrkak'

	 ² ;j ÿrg;a tys ;nd.kakd Wmdx.j, w,xldrhg ydks jk 		

	   fldgia we;akï tajd o bj;a lrkak' Wod-  .iaj, uereKq w;= 	

		   wdÈh

	 ² ia:dk fjkia l< hq;= Wmdx. iqÿiq ;ekaj, ia:dk.; lrkak'

	 ² w¨f;ka we;=<;a l< hq;= Wmdx. iqÿiq ;ekaj,g fhdokak'
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n÷ka.; me< N+ñ w,xlrKhg 

fhdodf.k we;s whqre 

u,a iuÕ j¾Kj;a t<j¨ fndA. N+ñ w,xlrKhg 

o fhdodf.k we;s whqre

w,xlrKh lrk ,o N+ñh kv;a;= lsÍu

	 N+ñhl w,xldrh mj;ajd.ekSu i|yd th ukdj kv;a;= lsÍu 

b;d jeo.;a fõ' fuys § bgq l< hq;= jeo.;a ld¾hhka my; oelafõ' 

		  	 ²	 c,h fh§u

			   ²	 fmdfydr fh§u

			   ²	 ñh .sh m;% bj;a lsÍu

			   ²	 Ydlj,ska jefgk m;% w;=.d ±óu

			   ²	 l=re¨ Èh n÷kaj, j;=r Èkm;d udre lsÍu

			   ²	 wjYH úg Ydl lmamdÿ lsÍu

			   ²	 jd¾Isl ñhhk Ydl i|yd w¨f;ka Ydl isgqùu  

	 Tn úiska ks¾udKh lrk ,o w,xldr N+ñh fï whqßka kv;a;= 

lsÍfuka mdi,a N+ñh jvd;a is;a .kakdiq¨ ia:dkhla f,i mj;ajd.; 

yels jkq we;'							     
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1'3 f.j;af;a i;=ka we;s lruq ¤ wdydr imhuq
                                                                    

fuu mßÉfþoh wOHhkh lsÍfuka Tng"

•	 f.j;= mßirhl we;s l< yels i;=ka ldKav .; lsÍug;a"

•	 i;=ka we;s lsÍfï § iemhsh hq;= wjYH;d ±laùug;a" 

•	 úúO j¾Ok wjêj, miqjk i;=kag iemhsh hq;= wdydr ;SrKh 

lsÍug;a"

•	 m%foaYfhka imhd .; yels wuqøjH fhdod f.k wdydr i,dlhla 

ieliSug;a 

   							       yelshdjla ,efnkq we;'

	 f.j;a;g meñfKk úúO i;=ka ksÍlaIKh lsÍfuka o Tjqkaf.a 

meje;aug wjYH mßir moaO;shla f.dvk.d §fuka o uy;a úkaokhla 

,eîug yhjk fY%aKsfha § wms bf.k .;af;uq' wmf.a f.j;= wdY%s; j 

we;s lrkq ,nk úúO i;=ka ms<sn`o j ±ka wmf.a wjOdkh fhduq lruq'
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f.j;af;a § y÷kd .; yels úúO i;=ka
	 mßirfha cSj;ajk fndfyda i;a;aj j¾. w;=frka f.j;a; ;=< 

we;s lrkqfha we;eï i;a;aj j¾. mu‚' we;s lsÍfï wjYH;dj wkqj 

tu i;=ka ldKav .; l< yels h'

we;s lrkq ,nk wjYH;dj wkqj i;=ka ldKav

WÞ(-    Ã n,a,ka Ã n<¨ka Ã úis;=re mlaISka

	 Ã úis;=re uiqka Ã idjqka
w,xldrhg yd iqr;,hg

i;a;aj ksIamdok ,nd 

.ekSug

WÞ(-  Ã lsß fokqka    Ã t¿jka

       Ã lsls<shka  	 Ã ;drdjka

WÞ(-  Ã n,a,ka    Ã n<¨ka Ã idjqka

       Ã úis;=re mlaISka Ã úis;=re uiqka 
megjqka fnda lsÍug

lDIsld¾ñl lghq;=j,g    WÞ(-  Ã ó .jhka     

wdrlaIdjg WÞ(-  Ã n,a,ka

 
l%shdldrlu

	 Tfí mka;sfha ñ;=rka$ñ;=ßhka oi fofkl=f.ka muK hq;a 

lKavdhï ilid .kak' my; i`oyka j.=j Tfí wNHdi fmdf;a 

msgm;a lr f.k lKavdhï    idudcslhskaf.a ksjdij, iy f.j;=j, 

we;s lrk i;=ka ms<sn`o j f;dr;=re /ia lrkak' mka;sfha wfkl=;a 

lKavdhïj, f;dr;=re iu`. Tn lKavdhu úiska imhd .;a f;dr;=re 

ikaikaokh lrkak'

lKavdhï 

idudcslhdf.a 

ku

we;s lrk 

i;a;ajhska

tu i;a;ajhd 

wh;a jk 

j¾.h

tu i;a;ajhdf.ka 

,efnk m%fhdackh

     pdkl t<fokqka

mrúhka

laIsrmdhs

mlaIs

lsß ,nd .ekSug

iqr;,hg
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	 f.j;a;l we;s lrk i;=ka j¾. yd ixLHdj ;SrKh jkafka" 

i;=ka we;s lsÍfï wjYH;dj" f.j;af;a we;s bv lv" Tjqka /ln,d 

.ekSug f.ysñhkag we;s úfõlh" wd§ lreKq u; hs' f.j;a;l i;=ka 

we;s lsÍu u.ska wmg m%;s,dN /ila ,nd .; yels fõ'

f.j;a;l i;=ka we;s lsÍfï jeo.;alu

²  mjqf,a fmdaIK uÜgu by< kexùu 

   lsß fokqka yd ì;a;r ouk lsls<shka we;s lsÍfuka fmdAIHodhl 		

   wdydr ,nd.; yels h'

²  mjq,g wu;r wdodhula ,nd .; yels ùu 

   jeämqr we;s lsß iy ì;a;r o" úis;=re u;aiH megjqka wdÈh o 		

   wf,ú lsÍfuka wu;r wdodhï ,nd.; yels h'

² f.du" t¿ fmdfydr" l=l=,a fmdfydr wdÈh ,eîfuka f.j;a; ire 		

   fõ'

²  f.du" t¿ fmdfydr wdÈfhka cSj jdhqj ksIamdokh l< yels fõ'

²  uq¿;ekaf.hska bj;a lrk wkjYH t<j¿ fldgia" fmd,a l=vq" 	  	

   b;sßjk wdydr fldia lgq wdÈh i;=kag wdydr f,i Èh yels ùu 		

   ksid mßirh wmú;% ùu je<fla'

² ó ueiaika u.ska mqIam mrd.Kh isÿjk ksid fnda.j, m,odj jeä 		

  fõ'

² mßirfha ffcj úúO;ajh jeä fõ'

² ydjqka" ;drjka" úis;=re uiqka yd l=re,a,ka ksid mßirhg 			 

  w,xldrhla ,efí'

² ks;r i;=ka ±lSu yd y`v weiSu ksid udkisl ;Dma;shla we;s fõ'

² i;=kag wdorh lreKdj ±laùfuka is; m%ikak fõ'

f.j;a;l i;=ka we;s lsÍfï § ie,ls,su;a úh hq;= lreKq

	 iqfjka cSj;a ùu i`oyd wm yg" ksjdihla" wdydr yd iqjodhl 

mßirhla wjYH fõ' i;=ka we;s lsÍfï § o Tjqkag iemhsh hq;= uQ,sl 

wjYH;d lsysmhls'
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tajd kï"

²	 whym;a mßir ;;a;ajj,ska iy i;=rkaf.ka wdrlaId ù isàug 		

	 ksjdihla

²	 wjYH úg ks±,af,a yeisÍug hï bvlvla 

²	 iqÿiq wdldrfha wdydr 

²      m%udKj;a mßÈ c,h

²	 ffjoH m%;sldr

by; lreKq w;=frka i;=kag wdydr §u ms<sn`o j uola úuid n,uq'

i;a;aj wdydr

	 i;a;ajhskaf.a j¾Okhg" tÈfkod isÿ flfrk l%shdldrlïj,g 

yd frda.j,ska wdrlaId ù isàug Tjqkag ukd fmdAIKhla ,nd Èh hq;= 

fõ' tneúka i;=kag wdydr §u ms<sn`oj wjOdkh fhduq lsÍu b;d 

jeo.;a fõ' i;=ka .kakd wdydrfha we;s  Ô¾Kh l< yels fmdAIl 

fldgia wdydr ud¾.fha § YÍrhg Wrd.kakd w;r ;ka;= fyj;a fl¢ 

fldgia YÍrfhka neyer lrhs'

	 wdydrhl wvx.= Ô¾Kh l< yels fmdAIl m%udKh iy o< ;ka;= 

m%udKh wkqj i;a;ajhskag ,nd fok wdydr m%Odk jYfhka fldgia 

2lg fnod ±laúh yels h'

   

i;a;aj wdydr

i;=kag fok o< wdydr j¾.

²  úúO Ydlj, w;= - Wod(-.a,sßiSähd w;= ^jegudr w;=&

			         	 bms,a bms,a w;=

			         	 trnÿ w;=

			           fldia w;= 	
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.a,sßiSähd w;=  bms,a bms,a w;=

trnÿ w;= fldia w;=

	

² ;DK j¾. - i;a;aj wdydr f,i fhdod .kakd ;DK wdldr folls'

      ² lmd lEug fok ;DK ^ fmdAI ;DK& 

        ² W,d lEug fok ;DK ^ f.dapr ;DK& 

lmd lEug fok ;DK ^f.dapr ;DK& - fïjd óg¾ 1- 1 1$2 la muK Wig 

jefvk w;r lmd f.kjq;a .jhskag yd t¿jkag ,nd fohs'

      .sKs ;DK     fkamsh¾ ;DK      n%eflaßhd ;DK  
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W,d lEug fok ;DK ^fmdAI ;DK&- fïjd f.dapr ;DK j¾. fuka Wia 

fkdjk w;r W,d lEu i|yd ;DK msÜgks fj; i;=ka hjkq ,efí'

Wod(-

 
    msÜgks ;DK (buffalow grass) iuyr n%eflaßhd ;DK 

 

² lDIsld¾ñl w;=re M,

    Wod(- bj; ,k t<j¿ iy m,;=re fldgia 	

	    W÷" uqx wd§ rks, îcj, fmd;= 

          msÿre yd fjk;a OdkH fnda.j, bmke,s

² fjk;a Ydluh fldgia

   Wod(- flfi,a fldg" m,d j¾." fldia lgq

   
   fldia lgq     flfi,a fldg  m,d j¾. ^lx l=x& 

i;=kag fok idkaø wdydr j¾.

²  OdkHuh wdydr

	 Wod(-	 iy,a ksjqvq  

		  ncsß îc" 

		  wUrk ,o nv bßÕ= îc

		  wUrk ,o bo,a bßÕ= îc



39

 iy,a ksjqvq

ncsß îc

i;a;aj wdydr i|yd wUrk ,o nv bßÕ= 

îc

bo,a bß`.= msá
  

 ² mqkaklal= j¾.

	 úúO îc j¾.j,ska f;,a is£fuka miq b;sß jk fldgi mqkaklal= 

kñka ye¢kafõ'

	 Wod(- 	fmd,a mqkaklal=

		  ;, mqkaklal=

		  rglcq mqkaklal=

      
;, mqkaklal=fmd,a mqkaklal=
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² ud¿ l=vq (- u;aiH ksIamdokfha § bj; ,k fldgia úh<d l=vq lr 		

  idod .kakd i;a;aj wdydrhls'

² lrj, l=vq (- lrj, .nvdj, b;sß jk" ñksia mßfNdackhg kqiqÿiq 		

  lrj, l=vq lr idod .kakd i;a;aj wdydrhls'

² i;a;aj weg lgq l=vq (- uia ksIamdokfha w;=re M,hla jk i;a;aj 		

  weglgq ;ïnd l=vq lr idod .kakd i;a;aj wdydrhls'

² ismams lgq l=vq (- fn,s lgq l=vq lr idod .kakd i;a;aj wdydrhls'

    ud¿ l=vq     ismams lgq l=vq      i;a;aj weg lgq l=vq

 

l%shdldrlu 1'12

	 Tnf.a ksji yd f.j;a; weiqfrka imhd .; yels i;a;aj wdydr 

j¾. ,ehsia;=jla my; ±lafjk j.=jg wkqj ilia lrkak' fï i|yd 

Tfí mjqf,a jeäysáhkaf.a iydh ,nd .kak'

o< wdydr idkaø wdydr

    

wdydr u.ska i;=kag ,nd fok fmdaIl

²   Yla;s ckl wdydr - ldfndyhsfâ%Ü yd ,smsv nyq, j wvx.= wdydr 	

    fõ' fïjdhska i;a;ajhskag wjYH Yla;sh imhkq ,efí'

    Wod(- iqKq iy,a" nv bß`.=

²  j¾Ol wdydr - fm%daàka nyq, j wvx.= wdydr fõ' fïjd 			 

   i;a;ajhskaf.a YÍr j¾Okhg wjYH fõ' 

    Wod(- mqkaklal= j¾.

²  wdrlaIl wdydr - úgñka yd Lksc ,nd fok wdydr óg wh;a h'

   Wod(- i;a;aj weg lgq l=vq" ismams lgq l=vq" m,d j¾.
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i;=kag wdydr §fï § i,ld ne,sh hq;= lreKq

	 úúO j¾.fha i;=ka .kakd wdydr j¾. o úúO h' wjYH wdydr 

m%udK o úúO h' wdydr .kakd wdldr o úúO h' i;=ka we;s lrk 

wdldrh wkqj o" Tjqka miq jk j¾Ok wjêh wkqj o wdydr ,nd §fï 

l%u úúOdldr fõ' tneúka i;=kag wdydr §fï § i,ld ne,sh hq;= 

lreKq ms<sn`o j wms wjOdkh fhduq lruq'

²	 i;a;aj j¾.h

	 .jhd" t¿jd iy neg¨jd Ydl NlaIlfhda h'  Tjqkag o< ;ka;= 

wêl b;d r¿ wdydr jqj o cS¾Kh lr fmdaIKh ,nd .; yels h' ta 

i`oyd Tjqkaf.a wdydr ud¾. úfYaIfhka ilia ù we;' tneúka Tjqkaf.a 

wdydr f,i ;DK wd§ o< wdydr jeä m%udKhla ,nd Èh yels fõ'

l=l=<ka yd ;drdjka i¾j NlaIlfhda h' tkï Ydluh fuka u i;a;ajuh 

wdydr o wkqNj lr;s' Tjqkag r¿ wdydr cS¾Kh lsÍfï  úfYaI yelshdjla 

fkdue;s neúka idkaø wdydr jeämqr ,nd §u wjYH fõ' 

²	 i;a;ajhska isák j¾Ok wjêh

	 jhia uÜgu wkqj i;=ka úúO j¾Ok wjêj, isá;s' ta wkqj 

i;a;ajhska isák wjê lsysmhls' tajd kï megõ wjêh" jefvk wjêh" 

megjqka fyda ì;a;r ouk wjêh fõ'

.jhskaf.a j¾Ok wjê

	 megõ wjêfha miqjk .jhskag uõlsß îug bv yßk w;r 

j¾Okh jk úg o< wdydr yd idkaø wdydr ,nd Èh hq;= fõ' fuys § 

o< wdydrj,g wu;rj j¾Ol wdydr f,i mqkaklal= wdÈh ,nd §u 

jeo.;a fõ' .eí.;a yd lsß ,nd .kakd fokqkag o" jvd;a fmdaIHodhl 

o< wdydr iu. idkaø wdydr ,nd Èh hq;= h'

l=l=<kaf.a j¾Ok wjê

megõ wjêh jefvk wjêh ì;a;r ouk wjêh
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	 jhia uÜgu wkqj l=l=<ka isák wjê ms<sn`o j o wmf.a wjOdkh 

fhduq lruq' tu úúO wjêj,g wjYH fmdAIKh ,efnk mßÈ ilia 

lrk ,o wdydr ñY%K fjf<`ofmdf<ka ñ, § .; yels h'

wjêh ,nd fok wdydr ñY%Kfha 

ku

megõ wjêh

jefvk wjêh

ì;a;r ouk wjêh

Ñla uEIa

f.%dajia uEIa

f,ah¾ia uEIa

Ñla uEIa f.%daj¾ uEIa f,ah¾ uEIa

megõ wjêh 

i`oyd iqÿiq 

wdydr

jefvk wjêh 

i`oyd iqÿiq 

wdydr

megjqka ouk wjêh 

i`oyd iqÿiq wdydr

²	 i;=ka we;s lrk l%u

	 f.j;a;l i;=ka we;s lsÍfï § wkq.ukh l< yels l%u lsysmhls' 

i;=ka we;s lrkq ,nk l%uh wkqj wdydr ,nd fok wdldrh fjkia 

fõ'

	 úYd, f.j;= we;s úg i;=kag ks±,af,a weúo mßirfhka wjYH 

;rï wdydr  fidhd .ekSug wjldY ,nd foa' we;eï úg rd;%shg ,e. 

isàug muKla ksjdi f,i .j uvq" l=l=¿ l+vq wdÈh imhkq ,efí'

	 fuu l%uhg i;=ka we;s lrk úg my; oelafjk wdldrhg  

wdydr imhkq ,efí'

	  W,d lEug ;K ìï fj; heùu ^Wod(- .jhka&

	  wyq,df.k lEug mßirhg uqod yeÍu ^Wod(-' l=l=<ka" ;drjka&
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             W,d lEu     wyq,df.k lEu             

	 f.j;=j, bvlv iSñ; úg ojfia jeä ld,hla i;=ka ksjdi ;=< 

;nd.kakd w;r wdydr i;=ka <Õg f.keú;a fokq ,efí'

	 ;DK lmd f.kú;a ksjdi ;=< we;s wdydr n`ÿkaj,g ±óu 

	 Wod(- .jhkag

	 fld< w;= lvd ksjdi ;=< t,a,d ;eîu 

	 Wod(-' t¿jkag

	 idkaÿ wdydr ñY%K" wdydr n`ÿkaj,g ±óu

	 Wod(-' .jhskag$l=l=<kag

    
.jhskag wdydr iemhSu l=l=<kag wdydr iemhSu
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l%shdldrlu 

jefvk lsls<s megjqka i`oyd wdydr ñY%Khla idouq'

imhd .; hq;= øjH ^ñY%Kh lsf,da.%Eï 1la i`oyd&

yd,a ksjqvq 					     .%Eï 350	

nv bß`.= l=vq				    .%Eï 200 

fmd,a mqkaklal= 				    .%Eï 150 

iqKq iy,a 					     .%Eï 100		   		

uqx weg l=vq 					    .%Eï 100				  

lrj, l=vq 					    .%Eï 50				  

ismams lgq l=vq 				    .%Eï 25			 

úh<d l=vq lr.;a bms,a bms,a m;% 	 .%Eï 25	

^fï i|yd Tnf.a m%foaYfha iq,Nj mj;sk fjk;a wdydr øjH o fhdod 

.; yels h'&

ñY%Kh ieliSu

	 fuys § jeo.;a jkafka ish¨ u fmdaIl" ñY%Kh ;=< iu j me;sÍ 

;sfnk whqßka ñY% lsÍu hs' fï i`oyd wvq m%udKj,ska we;s øjHj,ska 

ñY% lsÍu wdrïN lr jeä m%udKj,ska we;s øjH olajd wkq ms<sfj<ska 

ñY% lsÍu wjYH fõ' ta wkqj uq,ska u ismams lgq l=vq yd bms,a bms,a 

m;% l=vq fyd`Èka ñY% lr thg lrj, l=vq  o" thg uqxweg l=vq o" thg 

iqKq iy,a o" thg l=vq lr.;a fmd,a mqkaklal= o" thg nv bß`.= l=vq 

o wkqms<sfj<ska ouñka b;d fyd`Èka ñY% l< hq;= h' fuu ñY%Kh yd,a 

ksjqvqj,g tl;= lr fyd`Èka l,jï lrkak' jefvk lsls<s megjqkag 

wdydr f,i Èh yels fõ' 

	 fuu ñY%Kh úh<s ia:dkhl .nvd lr ;eìh yels h'
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